
 

 

 

 

 

 

 

 

 

 

 

 

Z10k 
Stand-Alone Access Control System 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

1. Features 
 

- Stand alone operation, needs only a industry-standard low-voltage power supply to 
operate. 
- Supports up to 9999 users, with configurable access rights for each. 
- Comes with easy to use PC software to configure the access control device. 
(PC is used only for setup, device can operate completely stand-alone.) 
- Can control access to: 
- Drive through lanes 
- Building doors 
- Restricted areas 
- etc... 
- Provides relay contact to control: 
- Turnstile 
- Speed flap 
- Automatic barrier 
- Door buzzer 
- Motor driven door lock 
- etc... 
- Available for use with different access tokens: 
- Magnetic stripe cards 
- HiTag 125kHz RFID Tags in various shapes 
- High security Mifare RFID Tags, also in various shapes 
 
 

2. PC Software features 
 

- Built in database which can hold address and other information for all 9999 users. 
- Powerful search feature. 
- Built in support for a desktop reader/writer to encode user cards. 
- Up-/Download feature to transfer access control rights between PC and the actual 
Z10k device. 
- Database can be exported to and imported from a spreadsheet application. 
- Multi-language ready. 

 

 

 

 

 



 

 

 

3. Principle of operation 
 

The Z10k system provides access control for up to 9999 users. Each user is provided 
with an access control token. The type of token depends on the system in use, it may 
be: 
 
- A credit card sized magnetic stripe card. 
- A credit card sized card with embedded Hitag or Mifare transponder. 
- A coin sized token with embedded Hitag or Mifare transponder. 
 
Especially for the contactless Hitag or Mifare systems, the token manufacturers offer 
a large number of shapes, sizes and colors. 
 
This document will always talk about a "card" when it means one of the mentioned 
tokens, regardless of the type or shape actually in use. 
 
 
Card versioning 
 
Each card has, in addition to its user number (0001 - 9999) a separate version digit 
(0 - 7). 
Should a card get lost, a new card can be issued with the same user number, but the 
version digit increased by one. This will automatically render the lost card as invalid 
and avoids the necessity to issue a new user number to the card holder. 
 

 

 

 

 

 

 

 

 

 



 

 

4. Setting up system preferences 
 

To install the software, run the provided installer and follow the instructions.  
After installation, you will find the Z10k application in your start menu. 
 
When the application first starts up, it presents an empty database view. 
 
 

 

 

 

 

 

 

 



 

 

System type 
 
Prior to using the application, it will need to know the type of access control system 
you are running. Please open Preferences -> System configuration to display the 
setup dialog. 
 

 

 

 

 

 

 



 

 

 

First, you need to chose the system type: 
 
- Magstripe 

Select this if you have a magstripe reader, e.g. an insertion reader, swipe 
reader or motordriven magstripe reader. 

 
- Hitag 

This option is for use with a contactless Hitag reader, if you plan to use Hitag-
S or Hitag-2transponders from Philips. 

 
- Hitag (Motor driven) 

Same as above, but used if the reader is motorized. A motorized reader works 
on credit-cardsized Hitag transponders and pulls them into the reader while 
reading. This type of device is sometimes preferred when the reader is to be 
operated from inside a car. 

 
- Mifare 

Use this option if you plan to use Philips Mifare-1k or Mifare-4k transponders 
with a contactless reader. The Mifare system offers the highest security of all 
listed system types in terms of copy protection. 

 
 
Magstripe systems 
 
If you are using a magstripe system, you will need to chose which track will hold the 
access controldata. This value depends strongly on the magnetic card reader type in 
use and must be selected appropriately. Standard ISO cards are divided into three 
tracks 1 - 3. 
 

 

 

 

 

 

 

 

 



 

 

Mifare systems 
 
Sector selection 
Mifare cards are divided into several sectors. You can chose any number here if you 
plan to use the Mifare transponders with the Z10k system only. If the Mifare card is to 
be shared with non-Z10k systems, the chosen sector must not be the same as the 
sector(s) used by other systems. 
 
Key selection 
For a Mifare system to work properly, a secret key code must be chosen at 
installation time. Click on the "Key" button to open the appropriate dialog. 
 

 

Once a key has been chosen and cards have been encoded with it, the key cannot 
be changed anymore. If you change the key anyway, all cards encoded with the 
old key will stop to work.  
Do not lose this key. If you lose the key, you may have to re-encode all cards 
already in use. With up to 9999 cards per system, this may be much work.  
Do not disclose this key to others. Everyone in possession of the key will be able 
to create or copy existing cards. If you want to keep a written copy of the key, you 
should store it in a safe. Note: The program has to keep a copy of the key on your 
harddisk in order to be able to encodecards. It's the responsibility of the user to 
employ proper file protection by using the access control mechanism of the 
computer's operating system. 



 

 

Encoding 
 
The data on the card has to be encoded in some way. Each card is encoded with a 
number thatconsists of a constant part and the part that contains the user number 
(0001 - 9999). 
 
When the Z10k reader reads a card, it will first check that the constant part of the 
data that was read matches the constant part entered here. Then it will pick the user 
number from the place you have marked with ZZZZ and the version number from the 
part you marked with V. laces marked with X will be ignored by the reader. 
Finally, the user number is looked up in the database and checked if it is acceptable. 
 
So, to chose a proper encoding, you should set up the number so it contains a long, 
random, fixed number and the proper ZZZZ and V markings at some place. 
 
The longest possible encodings are as follows: 
 
Magstripe: 39 digits 
Hitag: 12 digits 
Mifare: 38 digits 
 
For maximum safety, the chosen encoding should use up the longest possible 
encoding and not contain any Xs. Only if you need to read already existing cards with 
a special encoding, putting in some Xs may be useful. 
 
Desktop reader 
 
If you have a desktop reader/writer that will be used to encode new cards, please 
specify the serial port it is connected to. The program will aid you in chosing the right 
setting by showing the names of all serial ports. A desktop reader connected via USB 
will show up as something like "HTTRDesk" or "Micore-Desk", depending on the 
type. 
 
Note: For Hitag and Mifare systems, the Z10k reader can also be used to encode 
cards. Just select the same serial port as below. 
 
Z10k reader 
 
In order to set-up the Z10k reader, it must be connected to the PC through a serial 
port. Please note that this connection is only necessary while setting it up. For normal 
operation, the Z10k reader does not need the PC connection. 
 
 
 
 



 

 

5. Setting up reader properties 
 
To configure the general settings of you Z10k reader, please open Preferences -> 
Reader properties to display the setup dialog. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Reader type 
 
This option is only necessary for magstripe readers. Here you have to chose the 
actual type of magstripe reader connected. This setting depends heavily on the 
hardware 
 

 
 
 
Reader type: 

Chose if you have an Insertion, Swipe or Motor (MCR/MBR) reader. 
 
 

Tracks: 
This selects the actual tracks your reader supports, not the track you chose to 
use on the cards. 

 
 
Eject: 

Motor readers only. Choses what to do on powerup, if there's still a card inside 
the reader. Eject is to be taken literally in that case, the card is actually thrown 
right out of the reader. 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Display 
 
Some readers come with an own display. While you are completely free to decide 
what is shown on the display in each situation, the program already comes with a 
handy set of default values. 
 
First chose the size of the display, which usually is: 
 
8x2 for Micore-Stack, HTTR-Stack 
 
20x2 for μCard (Magstripe) readers 
 
To use the default texts, push the "Standard" button. To edit the texts yourself, push 
the "Texts..." button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
The text editor will show an explanation what every text item means, so editing 
should be straighforward. There's also a set of eight user definable texts, which can 
be assigned to any card number in the database. So, you can even show "Hello, Mr 
Chairman", if the CEO of your company accesses the device... 
 
 
 
 
 
 
 
 
 
 



 

 

Signals 
 
This is for advanced users only. The readers already come pre-configured, so there's 
usually no need to set up the signals and conditions. 
 
The reader supports several user defined signals and conditions. 
 
An output signal is raised whenever a card is either rejected (Reject signal) or 
accepted (Signal groups 1 - 4). Each card can be assigned to one or more of the four 
signal groups. 
 
When an output signal is raised, it's assigned outputs (usually relay contacts) emit a 
pulse of a definable length. These pulses will in turn open the door, the turnstile, the 
barrier, your pick.. 
 
A condition is a specific state (on or off) of up to five inputs (usually an opto-isolated 
input). An input condition is always checked before a card is accepted. There's the 
main condition, which must be always met in order to accept any card whatsoever. In 
addition, there are four specific conditions (1 - 4) that can be assigned to any card 
number. The specific conditions are only checked for the card numbers which they 
are assigned. 
 
In real life, this feature is useful vor vehicle lanes, where the reader is connected to a 
vehicle presence detector. The reader will then only accept entry if there's really a 
vehicle present. 
 
 
Logging 
 
The reader's serial port can be configured to send out a log message any time a card 
is read. By keeping the reader connected with a PC, a data logger or a serial printer, 
it is possible to track all actions taken. 
 
The character selected for "Start" is always sent in front of a message, while the 
characters "End1" and "End2" are sent afterwards. Entering 0 (Zero) will disable the 
character, respectively. 
 
 
 
 
 
 
 

 



 

 

6. Database editing 
 

The database is always visible after starting the program, or by selecting the "Cards" 
tab in the main window. While the left part of the window displays a summary of 
database entries, the right part will always show the complete data set of one user. 
 
 
To edit the database, the Z10k reader is not necessary, because all data is also 
stored on the PC. Only after you are done editing, you need to connect the reader 
and synchronize it to the PC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Card pane 
 
 

 
 
The card pane displays the data that is actually stored inside the Z10k reader. It 
defines the access conditions for any one of the 9999 card entries. 
 
Version 

Lets you assign a version digit. This feature is helpful if the card holder has 
lost the card. Just chose the next version number and issue a new card. The 
lost one is automatically disabled. The maximum version number is 7. If that's 
used up, you might want to have a serious talk with the card holder... 

 
Disabled 

If this checkbox is turned on, the card will not be accepted. 
 

Text 
For readers with a display, this selects either the standard text or one of the 
eight user definable texts. 

 
Online 

Not yet supported. Keep at "No". 
 
Signals 

Lets you specify what happens when this card is accepted. Usually, only 
signal 1 is used. If the checkbox is checked, the card will be accepted and 
provide access. 
(TODO: Have software make sure that at least one signal is set, or the card is 
useless) 

 
Conditions 

Unused in most systems. In more advanced systems, this buttons will cause 
the card to be accepted only if the selected conditions are met. 
 
 
 



 

 

Customer pane 
 

 
 
The customer pane's contents are only stored in the PCs database. Technically, they 
are not needed for proper system operation. They are very helpful to keep track of 
the card holders however, if more than a few cards are issued. 
 
 
The system does not enforce the entry of any data in these fields, they can be kept 
empty if not needed. 
 
Even though the fields are tagged with names like "Address" or "E-Mail", you are 
completely free to enter any information you may find useful. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Buttons 
 

 
 
 
Encode 

Provided a desktop reader is present (or the Z10k reader itself is selected for 
that purpose), this button will cause the currently selected record to be issued 
to a card. A dialog box will appear and give instructions on how to proceed. 

 
Apply 

This button will apply any changes made to the Card and Customer fields and 
store them to the database. Note: The Z10k reader will not be updated. This 
has to be done manually, on the "Transfer" tab. 

 
Undo 

Undoes any changes makde to the Card and Customer field, by reading the 
old values back from the database. 

 
Delete 

Completely clears the currently selected database record. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Copying 
 
In order to enable a large number of cards at once, the properties of one card can be 
copied to a range of other cards. For that purpose, select "Copy" from the "Edit" 
menu. 
 
 

 
 
 
The dialog accepts a destination range. Also, it is possible to select which pane(s) to 
copy: Card data (Card pane) and Personal data (Customer pane). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

Searching 
 
With the database growing larger over time, it will become more difficult to find an 
existing entry. The search dialog, accessible from the "Edit" menu, comes to the 
rescue. 
 

 
 
 
Enter the text you want to search for and click "Search". All fields selected are 
searched for the text and the results are listed in the box below. 
By double clicking on a search result, the item is selected in the main window and 
ready to edit. 
 
The search field supports wildcard characters: The asterisk (*) will match any number 
of characters while the '?' character matches one arbitrary character. 
 
Example: Wa*er will match, e.g.: Waters, Warner, Walter, ... 
More advanced computer users may like to enter a regular expression by enclosing it 
in two slashes (/). 
 
 
 
 



 

 

7. Data transfer 
 
All changes made to the database are only stored on the PC yet. In order to update 
the Z10k reader itself, the "Transfer" tab in the main window is used. 

 
There are only a few button on this page. In order to use any of these buttons, first 
make sure the Z10k reader is properly connected to the PC and is powered up. 
 
Update 

Probably the most used button. This will only send these records to the Z10k 
reader that have changed since the last update. 

New 
This will send the complete set of data to the Z10k reader. Depending on how 
many items there are in the database, this can take a few minutes. Best used 
only after initially installing the system for the first time. 

Read 
This will read back the complete set of data from the Z10k reader. Warning: 
the reader does not store personal data, only access control information. 
While the transfer is in progress, it can be stopped with the cancel button at 
any time. 



 

 

8. Exporting 
 
The Software supports exporting and importing the database contents to other 
programs. The file format chosen for this purpose is "Symbolic Link (SLK)" as 
supported by e.g. Microsoft Excel and OpenOffice.org. 
 
By selecting "Export" from the file menu, the data can be written to a SLK file. After 
editing it with another program, it can be read back with the "Import" item from the file 
menu. 
 
Please leave the first row of the table intact, as it is necessary to properly sort the 
data back into the database. 
 
9. Backup 
 
You are advised to regularily back up the database. This is as easy as selecting 
"Backup" from the File menu and selecting a file name. The actual backup is a matter 
of seconds. 
 
(Technical note: The resulting backup is a ZIP-file containing the database data in a 
set of wellformed and valid XML files, complete with a DTD. The data can be 
processed with a number of XML tools. Think of it as a second way of exporting the 
data.) 
 
Should you ever lose or accidentally destroy the program's own data, you can always 
restore a backup with the "Restore" function of the "File" menu. 
 


